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Introduction
This section describes the features and functions of a Zebra printer that is running the 
Virtual Device-I application. 
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11Introduction
Overview
Overview
The Virtual Device-I application enables Zebra mobile and tabletop printers to work with 
many host systems that are using INTERMEC® 3400D printers. In most cases, no 
changes will be required to the host application. This feature can help customers to make 
a smooth transition to Zebra printers and save them the time and expense of having to 
rewrite their host software.

Virtual Device-I Features
The Virtual Device-I application:

• Uses existing features of Zebra printers, when available.

• Offers fonts similar to the original device. These fonts will use 120 KB or more of 
memory space.

• Supports the Bluetooth®, Serial, Ethernet, WLAN, and USB interfaces.

• Offers many outline fonts, barcodes, and specific commands and features of 
target printer models (see Table of Supported Commands on page 40).

• Provides support of INTERMEC 3400D commands (see Commands on page 39).
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Supported Printers
This manual describes the Virtual Device-I language for Zebra mobile and tabletop 
printers and should be used by any person who needs to support that language on one of 
the following Zebra printers:

For complete printer operation, use this manual in combination with the User Guide for 
your printer.

Configuring Network Connectivity
Your printer may be equipped with one or more of the following interfaces:

• Bluetooth—For detailed information to connect a Bluetooth device, refer to the 
Bluetooth User Guide.

• Wired print server—For detailed information, refer to the ZebraNet Wired and 
Wireless Print Servers User Guide.

• Wireless print server (a/b/g/n)—For detailed information, refer to the ZebraNet 
Wired and Wireless Print Servers User Guide.

For other connectivity options, refer to the User Guide for your printer. Copies of these 
manuals are available at http://www.zebra.com/manuals.

Printer Firmware

iMZ Series V73.19.6Z and later

QLn Series V68.19.6Z and later

ZT200 Series V72.19.6Z and later

ZT400 Series V75.19.7Z and later

ZT510 V80.20.02Z and later

ZT600 Series V80.20.02Z and later

ZD400 Series V77.19.14Z or V84.20.05Z and later

ZD500 Series V74.19.6Z and later

ZD600 Series V84.20.05Z and later

ZQ300 Series V81.20.06Z and later

ZQ500 Series V76.19.10Z and later

Note • The Virtual Device-I language is supported only on 203 dpi printers.
P1069056-003 Virtual Device-I User Guide 07/05/2018
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13Introduction
Notes
Notes
• Other command languages are disabled when running Virtual Device-I. However, 

Set/Get/Do (SGD) commands and file download all operate properly with Virtual 
Device-I enabled.

• Virtual Device-I fonts can only be used with Virtual Device-I commands. They 
cannot be used with other languages.

• The Virtual Device-I mode application will not respond to CPCL, ZPL, or EPL 
commands. Instead, commands will be processed by the Virtual Device-I 
application.
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Install, Register, and Enable
Virtual Device-I
This section provides you with instructions on how to install and enable the Virtual 
Device-I application on one or more Zebra printers. 
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15Getting Started
Acquiring the Virtual Device Application
Acquiring the Virtual Device Application

To get the Virtual Device app, perform the following from your computer:

1. Open a web browser and navigate to http://www.zebra.com/virtualdevices.

2. Locate your printer type in the list of printers, and then click Download Now.

3. Fill out the information on the Virtual Device Download Request form.

4. Click Submit.

5. Read the End User License Agreement.

6. Click Accept and Begin Download Now.

Your browser prompts you to open or save the archive containing the Virtual 
Device app.

7. Save and store the Virtual Device app archive file to your computer.

The archive file contains the following:

• The Virtual Device .NRD file to be downloaded to a Zebra printer.

• A .txt file that contains the SGD command for immediately activating the 
Virtual Device app.

8. Extract the files from the archive to your computer.
07/05/2018 Virtual Device-I User Guide P1069056-003
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Downloading the Virtual Device-I Application
Zebra provides two options to download the Virtual Device-I app to the printer.

• On a computer with the ZDownloader Utility

The ZDownloader Utility is the only method shown in this manual. For instructions 
on how to download and install the ZDownloader Utility, see ZDownloader Utility 
on page 120.

• On an Android device with the Zebra Printer Setup Utility for Android Devices 
(available for free on Google Play™)

For information on using the Zebra Printer Setup Utility for Android Devices and to 
download the user guide, navigate to www.zebra.com/setup.

Using ZDownloader

The ZDownloader application can update Virtual Device-I files in Zebra printers connected 
by Serial, Parallel, USB, and IP Ethernet networks.

Figure 1 • Initial ZDownloader Screen

Adding Printers to the ZDownloader List

There are two ways to add printers to the list: 

• Auto-Detect (use for USB or IP Ethernet interfaces)

• Manual add (use for Serial, Parallel, or IP Ethernet interfaces)

If your printer is connecting via the serial or parallel interfaces, or is not detected by using 
the Auto-Detect method, use the Manual Add method.
P1069056-003 Virtual Device-I User Guide 07/05/2018
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Downloading the Virtual Device-I Application
Auto-Detect Printers

Use Auto-Detect for USB or IP Ethernet interfaces. 

USB printers can only be added by using Auto-Detect. The ZDownloader utility can 
support as many USB printers as your computer can support (most computers typically 
can support up to 255).

Note • Ethernet connected printers are detected by the application broadcasting a 
UDP packet out onto the network. UDP port number 4201 is used for the discovery 
process. Some networks filter out UDP packets. This means that the ZDownloader 
utility may not be able to detect all of the printers on your network. See your network 
administrator for more information. If you are not able to Auto-Detect your network 
printers, follow instructions for manually adding a printer.
07/05/2018 Virtual Device-I User Guide P1069056-003
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To Auto-Detect printers connected via the USB or IP Ethernet interfaces, 
perform the following steps:

1. In the ZDownloader toolbar, select Printer > Auto-Detect.

OR

Right-click in the ZDownloader window and select Auto-Detect Printers.

The printers detected are added to the printer list.

Manually Add Printers

To manually add printers connected via the Serial, Parallel, or Network 
interfaces, perform the following steps:

1. In the ZDownloader toolbar, select Printer > Add….

OR

Right-click in the ZDownloader window and select Add Printer…. 

The following window appears.
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2. Add a printer name and your printer model in the appropriate fields.

3. What type of printer are you adding?

Adding a Serial Printer

1. Select the serial port to which the printer is connected.

If you are adding a… Then…

Serial Printer Go to Adding a Serial Printer.

Parallel Printer Go to Adding a Parallel Printer on page 21.

Network Printer Go to Adding a Network Printer on page 21.
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2. Click Port Settings.

The following window appears.

3. Adjust the settings as necessary. The printer’s serial port settings must match the 
computer’s serial port settings. For more information about the settings, refer to the 
User Guide for your printer.

4. Click OK to save the port settings.

5. Click OK to add the printer.
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Adding a Parallel Printer

1. Set Communication Type to Parallel.

The available parallel ports will be shown in the Port drop-down box.

2. Select the port to which the printer is connected. No additional configuration is 
necessary.

3. Click OK to add the printer.

Adding a Network Printer

1. Set Communication Type to Network. 

The following window appears.

2. Enter the printer’s IP address.

3. Click OK to save the network settings.

4. Click OK to add the printer.
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Modifying Printers in the List

To change printer settings for a printer in the list, perform the following steps:

1. Select the printer to modify. 

2. In the toolbar, select Printer > Modify Printer….

OR

Right-click on the printer and select Modify Printer….

The printer settings for the selected printer are displayed.

3. Modify the settings as desired.

4. Click OK to save the settings.
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Deleting Printers from the List

To delete printers from the list, perform the following steps:

1. Select one or more printers to delete. 

2. In the toolbar, select Printer > Delete.

OR

Right-click on one of the selected printers and select Delete Printer(s). 

The printer is removed from the list.
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Downloading the Virtual Device App to Selected Printers

To download the Virtual Device-I app to your printer(s), you must select the file to send to 
each printer. ZDownloader, by default, downloads files to one printer at a time. If you have 
multiple printers to update and want to speed up the process, you can increase the 
number of simultaneous downloads. 

To allow simultaneous downloads, perform the following step:

1. Click Tools > Options….

The following prompt appears.

2. Raise the number shown to allow multiple simultaneous downloads.

3. Click OK.

To download the Virtual Device app file to one or more printers, perform the 
following steps:

1. Select the printers to which you want to download the Virtual Device-I app file. To 
select multiple printers, hold down the Ctrl or Shift key, and then click on the desired 
printers.

Note • More simultaneous downloads require more of your computer resources. Some 
computers may slow down with simultaneous downloads or as more printers are added 
for simultaneous downloading.
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2. In the toolbar, select File > Select Firmware File….

OR

Right-click on one of the selected printers and select Select Firmware File….

3. Navigate to the Virtual Device app file that you acquired previously.

4. Click Open.

The file that you selected appears under Download File for the selected printers.

Printers that are present in the list but that do not have a file selected will be 
ignored when Downloading starts.

5. Start the download process by doing one of the following:

• Select Printer > Download to Selected. 

• Select the printer(s) of interest and select the Printer and then select 
Download To Selected.
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6. In the toolbar, select Printer > Download All.

OR

Right-click in the ZDownloader window and select Download All.

After downloading has begun, the progress of each printer will be shown in the 
Download Status column.

Canceling a Download in Progress

The Cancel Download toolbar button and the Printer > Cancel Download menu options 
become active when the files are downloading.

To cancel downloading to ALL printers in the list, perform the following step:

1. Click Printer > Cancel Download.

OR

Right-click in the ZDownloader window and select Cancel Download.

To cancel downloading to SPECIFIC printers in the list, perform the following step:

1. Select one or more printers with a download in progress.

2. Click Printer > Cancel Download.

OR

Right-click on a selected printer and select Cancel Download.
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Registering the Virtual Device
ZDownloader maintains a log file of all items downloaded to a Zebra printer along with the 
printer serial number. You can register your Virtual Device installation with Zebra Repair 
and Tech Support to ensure that a printer sent in for repair is returned with the Virtual 
Device installed, and when engaging Zebra Tech Support, they will have records of the 
item being loaded. To register your Virtual Device installation, you must send the log file 
created by ZDownloader to the Zebra log file management group.

ZDownloader Log File

To send the log file, complete these steps:

1. Based on your operating system, navigate to the appropriate folder:

• Microsoft® Windows® XP
C:\Program Files\Common Files\FirmwareDownloader

• Microsoft Windows 7, Windows 8, and Windows 10
C:\ProgramData\Zebra Technologies\Firmware Downloader and ZBI 
Key Manager

2. Copy the log file (DownloadLog.txt), and email to Zdownloader@zebra.com.

If you are downloading from several computers, you need to send the log file from 
each computer. If you download files to printers on one day and do not send the 
file the same day, please note this in your email so that the log file management 
group picks up the previous load detail. Otherwise, they only pick up the load data 
for the day that the log file is sent. 
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Enabling the Virtual Device
You can enable Virtual Device-I by sending a Set/Get/Do (SGD) command to the printer 
or by selecting the option through the printer’s menus.

Using an SGD Command

To enable Virtual Device-I on your printer, send the following command:

! U1 setvar "apl.enable" "apl-i" 

To disable Virtual Devices on your printer and return to normal function, send the following 
command:

! U1 setvar "apl.enable" "none"

You must restart the printer after changing the value of apl.enable. For more information 
about this SGD command, see apl.enable on page 119.

Using the User Menus

This section includes instructions for the following printers:

• QLn420 Printers on page 29

• QLn320 and QLn220 Printers on page 32

• ZT230, ZT400 Series, ZT510, ZT600 Series, ZD500 Series, and ZD600 Series 
Printers on page 35

If necessary, refer to the User Guide for your printer for additional information about your 
printer’s control panel. 
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QLn420 Printers

1. From the printer’s idle display screen, press the LEFT SOFT KEY to select the Home 
icon.

The printer displays the Home Menu.

2. Use the ARROWS to navigate to the LANGUAGE menu.

PRINTER READY

VXXXXXXX

 SETTINGS 

 LANGUAGE 
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3. Press the OK button.

The printer displays the LANGUAGE selection screen.

4. Use the LEFT or RIGHT ARROW to navigate to the VIRTUAL DEVICE selection 
screen.

LANGUAGE

▼ ENGLISH ▲

VIRTUAL DEVICE

▼ NONE ▲
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5. Use the UP or DOWN ARROW to scroll to the APL-I option.

6. Press the RIGHT SOFT KEY to select USE.

The printer restarts and uses the Virtual Device that you selected.

VIRTUAL DEVICE

▼ APL-I ▲

USE
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QLn320 and QLn220 Printers

1. From the printer’s idle display screen, press the LEFT SOFT KEY to select the Home 
icon.

The printer displays the Home Menu.

2. Use the ARROWS to navigate to the SETTINGS menu.

Zebra QLn320
FW ver: XXXXXXXXXX
Baud Rate: 115200
Battery ok
IP Addr: 10.14.205.138

Menu

Communication Back

Settings Back
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3. Press the OK button.

The printer displays the VIRTUAL DEVICE selection screen.

4. Press the RIGHT ARROW to highlight the up arrow on the display.

5. With the up arrow highlighted, press the OK button until you scroll to the APL-I option.

Virtual Dev: none ▲ ▼

Menu Use Back

Virtual Dev: apl‐i ▲? ▼

Menu Use Back
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6. Press the LEFT ARROW to highlight APL-I

7. Press OK to select USE.

The printer restarts and uses the Virtual Device that you selected.
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ZT230, ZT400 Series, ZT510, ZT600 Series, ZD500 Series, and ZD600 Series 
Printers

1. From the printer’s idle display screen, press the LEFT SELECT KEY to select the 
Home icon.

The printer displays the Home Menu.

Note • The ZT230 control panel is shown in this procedure. The control panel for the 
other printers is similar.

PRINTER READY

VXXXXXXX

HOME MENU

SETTINGS
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2. Use the ARROWS to navigate to the LANGUAGE menu.

3. Press the OK button.

The printer displays the LANGUAGE selection screen.

HOME MENU

SETTINGS

▼
LANGUAGE

ENGLISH ▲
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4. Use the LEFT or RIGHT ARROW to navigate to the VIRTUAL DEVICE selection 
screen.

5. Use the UP or DOWN ARROW to scroll to the APL-I option.

▼
VIRTUAL DEVICE

NONE ▲

▼
VIRTUAL DEVICE

APL-I ▲

USE
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6. Press the RIGHT SOFT KEY or OK to select USE.

The printer restarts and uses the Virtual Device that you selected.

▼
VIRTUAL DEVICE

APL-I ▲

USE
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Commands
This section provides a detailed listing of commands for use on your Zebra printer with the 
Virtual Device-I app.
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Table of Supported Commands

Command Function

Immediate Commands

<EM> on page 45 Abort Print Job

<BEL> on page 45 Error Code, Request

<ESC>L on page 45 Label and Gap Length, Transmit

<ESC>Q on page 46 Remaining Quantity and Batch Count, Transmit

<DLE> on page 46 Reset

<VT> on page 46 Status Dump

<ENQ> on page 47 Status Inquiry

Print Commands

<ESC>Cn on page 48 Advanced Mode, Select

<GS> on page 48 Alphanumeric Field Separator

<US>n on page 49 Batch Count, Set

<CAN> on page 49 Clear All Data

<DEL> on page 49 Clear Data From Current Field

<NUL> on page 50 Command Terminator 1

<LF> on page 50 Command Terminator 2

<ESC>p on page 50 Configuration Parameters, Transmit

<SO> on page 51 Cut

<SUB> or <DLE> on page 51 Data Shift – International Characters

<ESC>gm on page 51 Direct Graphics Mode, Select

<ESC>cn on page 51 Emulation Mode, Enter

<ESC>Fn on page 52 Field, Select

<ESC>Dn on page 53 Field Decrement, Set

<ESC>In on page 53 Field Increment, Set

<ACK> on page 53 First Data Entry Field, Select

<ESC>vn on page 54 Font, Transmit

<FF> on page 54 Form Feed

<ESC>En,m on page 55 Format, Select

<ESC>xn on page 56 Format, Transmit

<ESC>N on page 56 Increment and Decrement, Disable

<ESC>mn on page 56 Memory Usage, Transmit

<CR> on page 57 Next Data Entry Field, Select

<FS> on page 57 Numeric Field Separator

<ESC>O on page 58 Options Selected, Transmit

<ESC>Gn on page 58 Page, Select
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<ESC>yn on page 59 Page, Transmit

<ETB> on page 59 Print

<ESC>H on page 59 Printhead Parameters, Transmit

<ESC>P on page 60 Program Mode, Enter

<ESC>Mn on page 60 Program Number, Transmit

<RS>n on page 60 Quantity Count, Set

<ESC><SP> on page 61 Start and Stop Codes (Code 39), Print

<ESC>T on page 61 Test and Service Mode, Enter

<ESC>u on page 61 User-Defined Characters, Transmit

<ESC>Z on page 61 User-Defined Tables, Transmit

<BS> on page 62 Warm Boot

Configuration Commands

<SI>N on page 63 Amount of Storage, Define

<ESC>j on page 63 Auto-Transmit 1, Enable

<ESC>d on page 63 Auto-Transmit 2, Enable

<ESC>e on page 64 Auto-Transmit 3, Enable

<ESC>k on page 64 Auto-Transmit 1, 2, and 3, Disable

<SI>cn on page 64 Cutter, Enable or Disable

<SI>dn on page 65 Dark Adjust, Set

<SI>Cn on page 65 Emulation or Advanced Mode on Power-Up

<SI>Dn on page 65 End-of-Print Skip Distance, Set

<SI>in on page 66 IBM Language Translation, Enable or Disable

<SYN>n on page 66 Intercharacter Delay, Set

<SI>fn on page 67 Label Rest Point, Adjust

<SI>Rn on page 67 Label Retract, Enable or Disable

<SI>rn on page 67 Label Retract Distance, Set

<SI>Tn on page 68 Label Stock Type, Select

<SI>Wn on page 68 Label Width, Set

<SI>L on page 68 Maximum Label Length, Set

<SI>gn,m on page 69 Media Sensitivity, Select

<ESC><SYN>n on page 69 Message Delay, Set

<SI>I on page 69 Number of Image Bands, Set

<EOT>n on page 70 Postamble, Set

<SOH>n on page 70 Preamble, Set

<SI>Sn on page 71 Print Speed, Set

<SI>ln on page 71 Printer Language, Select

<SI>hn,m on page 72 Printhead Loading Mode, Select

Command Function
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<SI>tn on page 72 Self-Strip, Enable or Disable

<SI>Fn on page 73 Top of Form, Set

Program Mode Commands

cn,m1,m2,m3 on page 74 Barcode, Select Type

c0m on page 75 Code 39

c1 on page 76 Code 93

c2,m on page 76 Interleaved 2 of 5

c3,m on page 77 Code 2 of 5

c4,m on page 77 Codabar

c5,m on page 78 Code 11

c6,m1,m2 on page 78 Code 128

c7,m1,m2 on page 79 UPC/EAN

c8,m1,m2 on page 80 HIBC Code 39

c9 on page 81 Code 16K

c10 on page 81 Code 49

c11 on page 82 POSTNET

c12,m1,m2,m3 on page 83 PDF417

c14,m1 on page 86 MaxiCode

c15,m1 on page 88 JIS-ITF

c16,m1,m2 on page 89 HIBC Code 128

c17,m1,m2,m3,m4,m5,m6 
on page 90

Data Matrix Symbology Versions ECC-100 and ECC-
200

c18,m1,m2,m3 on page 91 QR Code

c19,m1,m2 on page 92 MicroPDF417

Bn,name on page 93 Barcode Field, Create or Edit

yn on page 93 Bitmap Cell Height for Graphic or UDF, Define

xn on page 93 Bitmap Cell Width for Graphic or UDF, Define

Tn on page 94 Bitmap User-Defined Font, Clear or Define

bn on page 94 Border Around Human-Readable Text, Define

Wn,name on page 95 Box Field, Create or Edit

Xn on page 95 Character Bitmap Origin Offset, Define

rn on page 96 Character Rotation or Barcode Ratio, Define

p,n1,n2,n3,n4 on page 96 Code 39 Prefix Character, Define

C on page 97 Command Tables, Load

N on page 97 Current Edit Session, Save

en,m1,m2 on page 97 Data Source for Format in a Page, Define

Dn on page 98 Field, Delete

Command Function
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dn,m1,m2 on page 98 Field Data, Define Source

f on page 99 Field Direction, Define

on,m on page 99 Field Origin, Define

Zn on page 100 Font Character Width, Define

cn,m on page 100 Font Type, Select

A or F on page 100 Format, Create or Edit

qn on page 101 Format Direction in a Page, Define

En on page 101 Format, Erase

On,m on page 101 Format Offset Within a Page, Define

mp on page 102 Format Position From Page, Delete

Mp,n on page 102 Format Position in a Page, Assign

cn on page 102 Graphic, Select

u on page 103 Graphic or UDC, Define

hn on page 103 Height Magnification of Bar, Box, or UDC, Define

Hn on page 103 Human-Readable Field, Create or Edit

zn on page 104 Intercharacter Space for UDF, Define

In on page 104 Interpretive Field, Edit

in on page 105 Interpretive Field, Enable or Disable

ln on page 105 Length of Line or Box Field, Define

Ln on page 105 Line Field, Create or Edit

J on page 106 Outline Font, Clear or Create

j on page 106 Outline Font, Download

Sn on page 106 Page, Create or Edit

sn on page 107 Page, Delete

gn on page 107 Pitch Size, Set

kn on page 107 Point Size, Set

v on page 108 Print Line Dot Count Limit, Set

R on page 108 Program Mode, Exit

Gn on page 108 User-Defined Character, Clear or Create

Un on page 109 User-Defined Character Field, Create or Edit

tn on page 109 User-Defined Font Character, Create

wn on page 110 Width of Line, Box, Bar, or Character, Define

Test and Service Commands

A on page 111 Ambient Temperature, Transmit

; on page 111 Command Terminator

K on page 111 Dark Adjust

D on page 111 Factory Defaults, Reset

Command Function
07/05/2018 Virtual Device-I User Guide P1069056-003



Commands
Table of Supported Commands

44
f on page 112 Formats, Print

h on page 112 Hardware Configuration Label, Print

T on page 113 Label Taken Sensor Value, Transmit

p on page 113 Pages, Print

C on page 113 Pitch Label, Print

Q on page 114 Print Quality Label, Print

p on page 115 Printhead Temperature Sensor Value, Transmit

M on page 115 Reflective Sensor Value, Transmit

s on page 116 Software Configuration Label, Print

R on page 117 Test and Service Mode, Exit

G on page 117 Transmissive Sensor Value, Transmit

g on page 118 User-Defined Characters (UDC) and Graphics, Print

t on page 118 User-Defined Fonts, Print

Command Function
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Immediate Commands
Immediate commands are executed when the printer receives them. The printer mode 
does not matter. 

<EM>

Description  Abort Print Job

Purpose  To abort the current print job.

Syntax  <EM>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The printer stops printing the current batch, but continues processing the other 
commands in the buffer. The batch count is reset.

<BEL>

Description  Error Code, Request

Purpose  To check the printer for errors and warnings.

Syntax  <BEL>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The error code is either a command syntax error or a RAM usage error. A 
returned ASCII number represents the latest error. 
Important • If no error has occurred since the last power up, the printer returns a zero. 
When this command is sent, the error code is always reset to 00.

<ESC>L

Description  Label and Gap Length, Transmit

Purpose  To send the label length and gap length to the host.

Syntax  <ESC>L

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  If you are using continuous media, the printer sends the length identified by the 
Maximum Label Length, Set command. Label length is the length of the current label. If the 
current label is longer than the distance between the printhead and the sensor, then the 
previous label’s length is used.
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<ESC>Q

Description  Remaining Quantity and Batch Count, Transmit 

Purpose  To send the remaining quantity and batch counts to the host.

Syntax  <ESC>Q

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command transmits the batch and quantity counts for the active print job.

<DLE>

Description  Reset

Purpose  To start a printer power-up reset immediately.

Syntax  <DLE>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command erases all data in the input buffer and causes the printer to cycle 
power.

<VT>

Description  Status Dump

Purpose  To upload the current status to the printer.

Syntax  <VT>

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

• Error messages not supported: The printhead test fail and takeup reel full 
errors are not transmitted by this command, but all other error messages are.
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<ENQ>

Description  Status Inquiry 

Purpose  To send the current printer status to the host.

Syntax  <ENQ>

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

• Error messages not supported: The printhead test fail and takeup reel full 
errors are not transmitted by this command, but all other error messages are.
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Print Commands

<ESC>Cn

Description  Advanced Mode, Select

Purpose  To switch the printer to Advanced Mode.

Syntax  <ESC>Cn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  When switching between Advanced Mode (default) and Emulation Mode, all 
entered data is lost. Page 0 is the default page, and the field pointer selects the first field in 
format 0.

<GS>

Description  Alphanumeric Field Separator

Purpose  To increase/decrease alphanumeric characters in a field separated domain.

Syntax  <GS>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  It is possible to have numerous data regions in one field as long as they do not 
overlap. Each region separately increments or decrements depending on the value 
entered for the specific field. Data length remains the same when setting values of 
increments or decrements. Values increase or decrease in a circular motion, that is, 9 
increases to 0. The command identifies the areas of character to increase or decrease 
without actual changes. 
Important • The printer does not recognize non-alphanumeric values.
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<US>n

Description  Batch Count, Set

Purpose  To identify the amount of labels to print in the next batch.

Syntax  <US>n

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  When it is used the printer, it prints a certain amount of the same label. The 
amount is calculated by multiplying the number of batches by the amount in each batch.

Important  If the amount is out of range, an error code 21 is generated.

<CAN>

Description  Clear All Data

Purpose  To clear data from previous format.

Syntax  <CAN>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  After you select:

• a format—the pointer specifies the first field

• a page—the pointer specifies the first data field in the format.

<DEL>

Description  Clear Data From Current Field

Purpose  To clear data from present field.

Syntax  <DEL>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  After clearing the data, the field pointer continues to specify the current field.
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<NUL>

Description  Command Terminator 1

Purpose  To stop the present command.

Syntax  <NUL>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

<LF>

Description  Command Terminator 2

Purpose  To stop the present command.

Syntax  <LF>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

<ESC>p

Description  Configuration Parameters, Transmit

Purpose  To send the present printer configuration commands to the host.

Syntax  <ESC>p

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

• Parameters not supported: Security level, audible alarm, power up mode, 
top position, printhead pressure, number of image bands, amount of storage, 
online power up test parameters, and printhead test are not supported by the 
printer. The values transmitted for them are static default values.
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<SO>

Description  Cut

Purpose  To move the label to the cutter and cut.

Syntax  <SO>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  To run the Cut command, the cutter device must be present and not yet enabled. 
Send this command after printing stops.

<SUB> or <DLE>

Description  Data Shift – International Characters

Purpose  To enter certain command characters in a data field.

Syntax  <SUB> or <DLE>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command enables you to use command characters as data characters in 
Advanced and Emulation modes. It shifts the next character into the upper data bank. As a 
result, to print international characters, the eighth bit is set to 1. 

<ESC>gm

Description  Direct Graphics Mode, Select

Purpose  To enable faster image printing by not saving the graphic with the Virtual 
Device-I format.

Syntax  <ESC>gm

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The m argument specifies the type of the user-defined graphic data.
Default Value: m = 0
Accepted Values: 

0 = 8 bits per byte
1 = 8 bits per byte, nibblized

<ESC>cn

Description  Emulation Mode, Enter
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Purpose  To switch the printer to Emulation mode. 

Syntax  <ESC>cn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command allows you to print labels with barcodes in multiples of 10 or 15 mil 
that were designed on an 86XX printer. 
Default Value: n = 0 

Values for n: 
0 = 10 mil dot size
1 = 15 mil dot size for barcodes only.
Everything else is 10 mil. 

<ESC>Fn

Description  Field, Select

Purpose  To choose a data field for data entry.

Syntax  <ESC>Fn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  You must set the parameter for this command to the field number or the field 
name.

Things to be aware of:

• If you do not set the 3parameter, the printer defaults it to 0.

• If you choose the field number, the printer enters data into field n.

• If you enter a field name, the printer enters the data into a field with a 
particular name. 

• You must enclose the field name in quotation marks. 

• Entering an invalid field code generates error code 38.
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<ESC>Dn

Description  Field Decrement, Set

Purpose  To set the field decrement value.

Syntax  <ESC>Dn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  In order to decrement the values in data entry fields, sections of data must be 
separated by <FS> or <GS>. The printer decrements by a previously specified amount. 

Important  If the amount is out of range, error code 22 is generated.

<ESC>In

Description  Field Increment, Set 

Purpose  To set the field increment value.

Syntax  <ESC>In

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  To use this command, you must create a format in programming mode. In order to 
increment the values in data entry fields, sections of data must be separated by <FS> or 
<GS>.

<ACK>

Description  First Data Entry Field, Select

Purpose  To set the first data entry field to receive print mode data.

Syntax  <ACK>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  If you do not want to use a number to select a data field, this command ensures 
that the data prints in the lowest numbered field.
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<ESC>vn

Description  Font, Transmit

Purpose  To upload printer fonts.

Syntax  <ESC>vn

Not Supported  This command does not work on the Zebra printer with Virtual Device-I, 
or it has significant deviations from the 3400D printer.

<FF>

Description  Form Feed 

Purpose  To feed a label.

Syntax  <FF>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Things to be aware of:

• When printing on non-continuous media, the label is appropriately fed to the 
tear bar at its mark, gap, or web. 

• When using continuous media, the printer feeds the label by the specified 
amount. When printing on self-strip media, the printer feeds one blank label.
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<ESC>En,m

Description  Format, Select

Purpose  To choose a format for either data entry or output.

Syntax  <ESC>En,m

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer. 

Default: n = 0 

Values for n: *, 0 – 19 
Values for m: not available

Notes  Things to be aware of:

• n represents the numeric format ID, and m dictates to only re-image the 
changed fields.

• If any page is selected other than 0, n becomes an alphanumeric format 
position ranging from a–z.

• After a format is selected, the field pointer directs you to the lowest numbered 
data entry field.

• For the re-imaging command to work successfully and retain the image, the 
printer must be able to fully image a label within the range of available image 
bands.

• The printer erases all host entered/variable data from the format.

Important  If an invalid format number is entered, error code 36 is generated.
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<ESC>xn

Description  Format, Transmit

Purpose  To send a printer format to the host.

Syntax  <ESC>xn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Things to be aware of:

• If <ESC>x is sent to the printer without specifying the value for n, the printer 
uploads the complete format directory. The format directory is in the following 
format: 

• [Idnumber][name][type][storage size]<CR><LF>. [Idnumber] is the 
value identified by n. [name] is the name set out in the command that created 
the format. [type] is 0. [storage size] is the amount of memory necessary 
to store the format. 

• If you enter an incorrect number, an error code 25 is generated. 

• The printer must stay in Advanced mode.

<ESC>N

Description  Increment and Decrement, Disable   

Purpose  To clear the present field’s increment or decrement settings.

Syntax  <ESC>N

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Both the decrement and increment flags are reset for the selected field.

<ESC>mn

Description  Memory Usage, Transmit

Purpose  To display the amount of printer memory being used. 

Syntax  <ESC>mn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Initially, the printer sends the amount of total storage available. Then the printer 
sends the amount of available RAM that is not being used and the amount of total RAM, 
for example: 32,10.
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<CR>

Description  Next Data Entry Field, Select

Purpose  To move the field pointer to the next data entry field.

Syntax  <CR>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Important  Things to be aware of:

• If you have not selected a page and the pointer is in the last field, it moves to 
the first data entry field. 

• If you have selected a multi-format page, the pointer moves from the last field 
in the first format to the first field in the next format.

<FS>

Description  Numeric Field Separator

Purpose  To identify numeric data in a field to increase or decrease.

Syntax  <FS>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  It is possible to have numerous data regions in one field as long as they do not 
overlap. Depending on the value entered for the specific field, each data region separately 
increments or decrements. The data length remains the same when setting values of 
increments or decrements. 

Important  Values increase or decrease in a circular motion. For example, 9 increases to 
0. The printer does not recognize non-alphanumeric values.
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<ESC>O

Description  Options Selected, Transmit

Purpose  To transmit the selected options list.

Syntax  <ESC>O

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Values returned by printer:    

0 = No options selected 
1 = Cutter
2 = Self Strip

<ESC>Gn

Description  Page, Select

Purpose  To choose a page for either data entry or output.

Syntax  <ESC>Gn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  If you select a type of page, the pointer designates the first entry field in the lowest 
numbered format. 
Important • Things to be aware of:

• All user-entered data is erased. 

• If an invalid page number is entered, an error code 36 is generated.
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<ESC>yn

Description  Page, Transmit

Purpose  To upload a printer page and show commands that create a format.

Syntax  <ESC>yn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Things to be aware of:

• Sending <ESC>y without designating a value for n causes the printer to upload 
the complete page directory. 

• The page directory is in this format: 

[Idnumber][name][type][storage size]<CR><LF>

[Idnumber] is the value identified by n. [name] is the name set out in the 
command that created the page. [type] is 1. [storage size] 0. 

• If you enter an invalid number, error code 26 is generated. 

• The printer must remain in Advanced mode.

<ETB>

Description  Print

Purpose  To print the present page or format. 

Syntax  <ETB>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Prints the format with the data that was previously entered.

<ESC>H

Description  Printhead Parameters, Transmit

Purpose  To send the number of dots and dot size in the printhead to the host. 

Syntax  <ESC>H

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Example   This is an example of a transmitted printhead parameter value: 895.5.0.
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<ESC>P

Description  Program Mode, Enter 

Purpose  To switch to Program mode.

Syntax  <ESC>P

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Using this command erases all previously entered data.

<ESC>Mn

Description  Program Number, Transmit

Purpose  To send program and version number.

Syntax  <ESC>Mn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command uploads the program number and software version to the host 
computer. The data is represented as an ASCII alphanumeric character string.

<RS>n

Description  Quantity Count, Set

Purpose  To set the number of printed label batches.

Syntax  <RS>n

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Data increments and decrements occur between batches of labels. 

Important  If the quantity is out of range, error code 21 is generated.
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<ESC><SP>

Description  Start and Stop Codes (Code 39), Print

Purpose  To print a Code 39 barcode with no data.

Syntax  <ESC><SP>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The printer erases all data in the current field.

<ESC>T

Description  Test and Service Mode, Enter

Purpose  To switch to Test and Service mode.

Syntax  <ESC>T

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  If this command is sent, any previously sent host data is erased. The printer 
enters Test and Service mode after the printer completes all jobs.

<ESC>u

Description  User-Defined Characters, Transmit

Purpose  To send a graphic to the host.

Syntax  <ESC>u

Not Supported  This command does not work on the Zebra printer with Virtual Device-I, 
or it has significant deviations from the 3400D printer.

<ESC>Z

Description  User-Defined Tables, Transmit

Purpose  To send the user-defined command and protocol tables so that the printer gets 
to download a new command set.

Syntax  <ESC>Z

Not Supported  This command does not work on the Zebra printer with Virtual Device-I, 
or it has significant deviations from the 3400D printer.
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<BS>

Description  Warm Boot

Purpose  To reset the printer after other commands in the buffer are executed.

Syntax  <BS>

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command is executed after all previous commands are completed. Any 
information sent after this command is lost. When configuration commands require a 
printer reset, use this command.
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<SI>N

Description  Amount of Storage, Define

Purpose  To determine the amount of RAM that is allocated for storage.

Syntax  <SI>N

Partially Supported  Based on testing, this is a partially supported command with the 
following differences and outputs:

• This command does not define the amount of memory in the printer because 
this is done by the hardware. However, when this command is executed, user-
defined formats, fonts, and graphics are erased from memory. 

<ESC>j

Description  Auto-Transmit 1, Enable 

Purpose  To enable auto-transmit 1.

Syntax  <ESC>j

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

• Error messages not supported: The takeup reel full error is not transmitted 
by this command, but all other error messages are. 

<ESC>d

Description  Auto-Transmit 2, Enable

Purpose  To enable auto-transmit 2.

Syntax  <ESC>d

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  With auto transmit level 2 enabled, the printer transmits the status code indicating 
there is room in the input buffer:

<DC1> = when using Virtual Device-I handshaking protocol 
<DC2> = when using XON/XOFF handshaking protocol

Without level 2 enabled, the host must determine the status using alternate commands 
(<VT> on page 46 or <ENQ> on page 47).
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<ESC>e

Description  Auto-Transmit 3, Enable

Purpose  To enable auto-transmit 3.

Syntax  <ESC>e

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

• Error messages not supported: The imager overrun, printing complete, and 
buffer empty errors are not transmitted by this command, but all other error 
messages are.

<ESC>k

Description  Auto-Transmit 1, 2, and 3, Disable

Purpose  To disable auto-transmit 1, 2, and 3.

Syntax  <ESC>k

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command turns off the auto transmit status responses.

<SI>cn

Description  Cutter, Enable or Disable

Purpose  To enable or disable the cutter option.

Syntax  <SI>cn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  With the cutter option installed, this command turns the cutter on or off.
Default Value: n = 0
Values for n: 

0 = Turns cutter off 
1 = Turns cutter on
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<SI>dn

Description  Dark Adjust, Set

Purpose  To set printer darkness.

Syntax  <SI>dn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Things to be aware of:

Default: n = 0
Values for n: 

+10 is the darkest setting and –10 is the lightest setting, in increments of 1.

<SI>Cn

Description  Emulation or Advanced Mode on Power-Up

Purpose  To choose Emulation or Advanced mode when printer is turned on.

Syntax  <SI>Cn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer. 
Default Value: n = 1
Values for n: 

0 = Emulation mode (10 mil) 
1 = Advanced mode (5 mil)
2 = Emulation mode (15 mil)

Important  This command takes effect after power has been cycled on the printer.

<SI>Dn

Description  End-of-Print Skip Distance, Set

Purpose  To determine the end-of-print skip distance.

Syntax  <SI>Dn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer. 

Notes  This command is not usable in self-strip purposes. In order to advance the media 
to the tear bar, you have to enter a value for n. This value applies to continuous media and 
label stock media. Without entering a value for n, the printer uses the default setting.
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<SI>in

Description  IBM Language Translation, Enable or Disable

Purpose  To enable and disable the IBM language translation. 

Syntax  <SI>in

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command overrides the language translation on the printer. This allows IBM 
compatible characters to be used instead of ASCII characters derived from the printer’s 
language.
Default Value: n = 0 

Values for n: 
0 = disable IBM
1 = enable IBM

<SYN>n

Description  Intercharacter Delay, Set

Purpose  To determine the intercharacter delay for transmissions.

Syntax  <SYN>n

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command sets the delay time in milliseconds between characters in a printer 
transmitted message.

Default: n = 0 

Values for n: 0 – 9999
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<SI>fn

Description  Label Rest Point, Adjust

Purpose  To adjust where labels stop for removal when the printer is configured for 
non-continuous media.

Syntax  <SI>fn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  You can enable this control through the control panel.

Default: n = 0 

Values for n: –30 (backwards) to +30 (forward) in 5 mil increments

<SI>Rn

Description  Label Retract, Enable or Disable 

Purpose  To turn on or off the label retract feature when the printer is configured for 
continuous media.

Syntax  <SI>Rn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Things to be aware of:

Default: n = 1 

Values for n: 
0 = disables label retract 
1 = enables label retract 

<SI>rn

Description  Label Retract Distance, Set

Purpose  To set the label retract distance.

Syntax  <SI>rn

Not Supported  This command does not work on the Zebra printer with Virtual Device-I, 
or it has significant deviations from the 3400D printer.
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<SI>Tn

Description  Label Stock Type, Select

Purpose  To set the media type.

Syntax  <SI>Tn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The n argument specifies the media type.

Default: n = 1 

Values for n: 
n = continuous media
1 = non-continuous media with web or gaps separating labels
2 = non-continuous media with marks separating labels

<SI>Wn

Description  Label Width, Set

Purpose  To determine the label width.

Syntax  <SI>Wn

Not Supported  This command does not work on the Zebra printer with Virtual Device-I, 
or it has significant deviations from the 3400D printer. 

<SI>L

Description  Maximum Label Length, Set

Purpose  To identify the maximum label length.

Syntax  <SI>L

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command is primarily used for detecting media errors.
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<SI>gn,m

Description  Media Sensitivity, Select

Purpose  To choose the printers media sensitivity. 

Syntax  <SI>gn,m

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

• The first argument sets the media type; when n = 0, direct thermal media is 
selected, and when n = 1 thermal transfer media is selected. 

• The second argument of this command is not used. 

<ESC><SYN>n

Description  Message Delay, Set

Purpose  To determine the delay between transmissions.

Syntax  <ESC><SYN>n

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command determines the delay in milliseconds before all printer 
transmissions begin.

Default: n = 0    

Values for n: 0 – 9999 

<SI>I

Description  Number of Image Bands, Set

Purpose  To determine the number of image bands.

Syntax  <SI>I

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

• the number of image bands does not need to be set with this command since 
this quantity is automatically calculated while printing a label.
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<EOT>n

Description  Postamble, Set

Purpose  To determine the character that is sent before every transmission.

Syntax  <EOT>n

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Assigns the Postamble character.

Default: n = <NUL>
Values for n: Any ASCII character

With n equal to default value, a postamble character is not sent by the printer.

<SOH>n

Description  Preamble, Set

Purpose  To determine the character that is sent before every transmission.

Syntax  <SOH>n

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Assigns the Postamble character.

Default: n = <NUL>
Values for n: Any ASCII character 

With n equal to default value, a preamble character is not sent by the printer.
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<SI>Sn

Description  Print Speed, Set

Purpose  To determine the print speed.

Syntax  <SI>Sn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Defines the print speed.

Default: n = 30
Values for n: 20, 30, 40, 50, or 60 

20 = 2 inches per second (ips), 30 = 3  ips, et cetera.

<SI>ln

Description  Printer Language, Select

Purpose  To determine the printer language.

Syntax  <SI>ln

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Default: n = 0
Values for n: 0 to 10 

Notes  Only one language can be used for a print job. If it is necessary to use more than 
one language, you can either bitmap the TrueType fonts or create your own bitmap font. 
The default language selection should supply you with the necessary characters for a 
bitmap. However, if you are using a TrueType font, it is imperative that you match code to 
the language. If you downloaded a scalable font, you must first download the correct code.
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<SI>hn,m

Description  Printhead Loading Mode, Select

Purpose  To determine the printhead loading mode.

Syntax  <SI>hn,m

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Printing batches of labels in inverse mode is not recommended due to wear on 
the printhead. 

<SI>tn

Description  Self-Strip, Enable or Disable

Purpose  To enable or disable the self-strip feature.

Syntax  <SI>tn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Activates or deactivates the peel sensor. 

Default: n = 0

Values for n: 
0 = Peel Sensor Off   
1 = Peel Sensor On
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<SI>Fn

Description  Top of Form, Set

Purpose  To set the form top position.

Syntax  <SI>Fn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Sets the label top position in 5 mil increments from the position to the lead edge of 
the label.

Default: n = 20 

Values for n: –10 to 4000

Negative values allow you to minimize the distance between the print and edge of the 
label.
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Program Mode Commands

cn,m1,m2,m3

Description  Barcode, Select Type 

Purpose  To choose the barcode field type. 

Syntax  cn,m1,m2,m3

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command defines the Symbology of the barcode.
Values for n: 

0 = Code 39
2 = Interleaved 2 of 5
3 = Code 2 of 5
4 = Codabar
5 = Code 11
8 = HIBC Code 39
10 = Code 49
15 = JIS-ITF
16 = HIBC Code 128
17 = Data Matrix

If you use the Null character in the Barcode data stream, you will lose that character as 
well as any following data. If using any of the following control characters (<RS>, <GT>, 
<EOT>, et cetera), you have to precede it with a <SUB> character. 
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c0m

Description  Code 39

Purpose  To specify a Code 39 barcode field.

Syntax  c0m 

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command has one argument, m for mode, which defaults to 0.

These are the types of Code 39 that are supported: 

• Full ASCII

• 43 Character

• 8646 compatible

8646 Compatible is the same as full ASCII with the exception of four characters (the “+”, 
“/”, “%”, “$” are used as single characters rather than used as “/K”, “/O”, “/E”, “/D”). This 
version makes it backward compatible with the 86XX printers.

These are the supported Code 39 barcode modes:

m = Code 39 Mode
0 = No check digit, 8646 compatible barcode type.
1 = Printer provides check digit, 8646 compatible type.
2 = User provides check digit, which is verified by printer 8646 compatible type.
3 = No check digit, full ASCII type.
4 = Printer provides check digit, full ASCII type.
5 = User provides check digit, which is verified by printer, full ASCII type.
6 = No check digit, 43 character type.
7 = Printer provides check digit, 43 character type.
8 = User provides check digit, which is verified by printer, 43 character type.
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c1

Description  Code 93

Purpose  To specify a Code 93 barcode field.

Syntax  c1

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Things to be aware of:

• There are no arguments for the Code 93 barcode.

• If a string has an odd number of characters, the printer automatically adds a 
zero.

c2,m

Description  Interleaved 2 of 5

Purpose  To specify an Interleaved 2 of 5 barcode field.

Syntax  c2,m

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Things to be aware of:

• The c2 command has one argument, m for mode, which defaults to 0.

• The Interleaved 2 of 5 barcode supports these modes:
m = Interleaved 2 of 5 Mode
0 = No check digit.
1 = Printer provides check digit.
2 = User provides check digit.

• Zeros are added to any odd length strings.
P1069056-003 Virtual Device-I User Guide 07/05/2018



77Commands
Program Mode Commands
c3,m

Description  Code 2 of 5

Purpose  To specify a Code 2 of 5 barcode field.

Syntax  c3,m

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Things to be aware of:

• The c3 command has one argument, m for mode, which defaults to 0.

• The Code 2 of 5 barcode supports these modes:
m = Interleaved 2 of 5 Mode
0 = Start/stop code size is 3 bars.
1 = Start/stop code size is 2 bars.

c4,m

Description  Codabar

Purpose  To specify a Codabar barcode field.

Syntax  c4,m

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Things to be aware of:

• The c4 command has one argument, m for mode, which defaults to 0.

Default: m - 0
Values for m: m = 0

• The Codabar barcode supports these modes:
m = Codabar Mode
0 = User provides start/stop codes, which are verified by printer.
1,x,y = Printer provides start code x and stop code y, where x and y are values 

with ranges of A to D and a to d.

• You can send the start/stop characters as part of the human readable field of 
the barcode or as a separate text field (print data). Characters sent down as 
printer data override start/stop characters defined by the barcode field.
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c5,m

Description  Code 11

Purpose  To specify a Code 11 barcode field.

Syntax  c5,m

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Things to be aware of:

• The c5 command has one argument, m for mode, which defaults to 0. 

Default: m = 0
Values for m: 

• The Code 11 barcode supports these modes:
m = Code 11 Mode
0 = Printer provides two check digits.
1 = Printer provides one check digit.
2 = User provides two check digits, which are verified by the printer.
3 = User provides one check digit, which is verified by the printer.

c6,m1,m2

Description  Code 128

Purpose  To specify a Code 128 barcode field.

Syntax  c6,m1,m2

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

• The c6 command has one argument, m for mode, which defaults to 0.

• When more than 19 characters are specified as data, the first 19 are used as 
data

• When fewer than 19 are specified, data is zero-filled up to 19 characters. The 
first two characters are not forced to be zeros.

The Code 128 barcode supports these modes:
m = Code 128 Mode
0 = Printer provides two check digits.
1 = Printer provides one check digit.
2 = User provides two check digits, which are verified by the printer.
3 = User provides one check digit, which is verified by the printer.
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c7,m1,m2

Description  UPC/EAN

Purpose  To specify a UPC/EAN barcode field.

Syntax  c7,m1,m2

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs: 

These label examples show the difference between labels when entered data is 
too long: 

Barcodes not implemented: version D1-D5. When data entered is too long, an EAN-13 
barcode is printed.

Intermec 3400D Printer Label

Virtual Device-I Printer Label
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c8,m1,m2

Description  HIBC Code 39 

Purpose  To specify an HIBC Code 39 barcode field.

Syntax  c8,m1,m2

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The c8 command has two arguments, m1 and m2, and m1 defaults to 0. 

Default: m1 = 0 

Values for m1 Supplier Std.: 
0 = Primary format
1 = Backup Primary format
2,m2 = Second Data format. The linking character comes from the field identifier 
(m2 value)

Values for m1 Provider Std.: 
3 = Single format
4 = 1st data format
5,m2 = Second Data Format

The linking character comes from the field identifier (m2 value).

The HIBC Code 39 barcode supports these modes:

m1 HIBC Code 39 Mode

0 Primary format.

1 Alternate Primary format.

2,m2 Secondary format with m2 as the linkage character and field 
identifier.

3 Single format.

4 First data format. 

5,m2 Second data format with m2 as the linkage character and field 
identifier.

6 Multiple data format.
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c9

Description  Code 16K

Purpose  To specify a Code 16K barcode field.

Syntax  c9

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

• The Zebra printer with Virtual Device-I firmware does not support linked 
barcodes, or using a set of barcodes to print a single data string too large for 
one barcode.

c10

Description  Code 49

Purpose  To specify a Code 49 barcode field.

Syntax  c10 

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Things to be aware of:

• The c10 command has no arguments.

• Use a <SUB> 1 command to symbolize the function 1 character in Emulation 
mode. If using Advanced mode, you can symbolize the function 1 character 
by using the <SUB><SUB> 1. The same holds true for function characters 2, 3, 
and 4.

• To call up a square symbol in Advanced mode, use a height magnification of 
1. While in Emulation mode, use a magnification of 250.

Important  Only Alphanumeric (0) and numeric (2) modes are supported by the printer.
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c11

Description  POSTNET

Purpose  To specify a POSTNET barcode field.

Syntax  c11

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

These label examples show that the interpretive field commands have no effect 
on the barcode positioning, spacing, and sizing: 

Notes  The c11 command has no arguments.

Even if specified, an interpretive field is disabled by the command and does not print.

Origin difference  y-direction.

Intermec 3400D Printer Label

Virtual Device-I Printer 
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c12,m1,m2,m3

Description  PDF417

Purpose  To specify a PDF417 barcode field.

Syntax  c12,m1,m2,m3

m1, m2, and m3 are the three arguments of the c12 command.

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

These label examples show a slight difference in dot pattern, barcodes with non-standard 
characters print slightly smaller, and difference in magnification ranges.

Intermec 3400D Printer 

Virtual Device-I Printer Label
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Using ,m1 to Select the Number of Columns

Purpose  To set the number of columns in the PDF417 barcode.

Syntax  This parameter, which defaults to 0, is the number of columns of data characters; 
the range of values is 0 to 30.

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  ,m1 represents the number of columns needed to create a symbol. The range is 0 
(default) to 30. If you select 0, the printer automatically uses the number of columns 
necessary for the symbol that is closest to the shape of a square.

Using ,m2 to Select an Error Correction Level

Purpose  To set an error correction level for a PDF417 barcode.

Syntax  This parameter, which defaults to 9, is the error correction level; the range of 
values is 0 to 9. 

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The error correction level should be set according to the number of code words 
(compressed data) generated from the PDF417 barcode’s data. The table below shows a 
list of the values of m2, the corresponding suggested number of code words, and the error 
detection characters that will be generated at that setting.

Using ,m3 to Set the Truncate Flag

Purpose  This is an argument for the c12 command that customizes the PDF417 
barcode.

m2 Number of Code words
Error Detection Characters 
Generated

0 <not recommended> 2 (no error recovery)

1 <not recommended> 4

2 1-40 8

3 41-160 16

4 161-320 32

5 321-863 64

6 <reserved for special applications> 128

7 <reserved for special applications> 256

8 <reserved for special applications> 512

9 <printer automatically determines error 
correction level> varies
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Syntax  This parameter, which defaults to 0, is the truncate flag. When set, the barcode 
will print without right row indicators and with a one-module wide stop character.

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  It enables you to enable printing the symbol in truncated form or to disable 
printing in truncated form.

Default: m3 = 0
Values for ,m3,

0 = disables truncating
1 = enables truncating

It is highly recommended that you use the default setting for ,m3 in order to reduce errors 
and maintain a better reading performance.

This shows the maximum allowable characters for the 3 character sets.

Important  Use these guidelines. Due to the fact that 2-dimensional symbols encode 
data by compressing it, the capacity varies due to the data being encoded.

Character Set  Data Capacity

Full ASCII 1108

Alphanumeric 1850

Numeric 2725
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c14,m1

Description  MaxiCode

Purpose  To specify a Code MaxiCode barcode field.

Syntax  c14,m1 

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

Intermec 3400D Printer Label

Virtual Device-I Printer Label
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Notes  The c14 command has one argument, m for mode, which auto defaults between 
modes 2 through 4.

See the labels examples to see the differences between printers. 

• Interpretive field fonts could be different.

• Barcodes might print. They do not print on 3400D printers.

The MaxiCode barcode supports these modes:

m MaxiCode Mode

2 Structured Carrier Message format to be used with postal 
codes up to 9 digits long.

3 Structured Carrier Message format to be used with 
alphanumeric postal codes up to 6 digits or characters 
long.

4 Standard barcode.

5 Full EEC or enhanced error correction.

6 Reader programming mode.
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c15,m1

Description  JIS-ITF 

Purpose  To specify a JIS-ITF barcode field.

Syntax  c15,m

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The c15 command has one argument, m for mode, which defaults to 0. 
Default Value: m = 0
Values for n,m 

0 = 5 dot narrow magnification
1 = 8 dot narrow magnification
2 = 10 dot narrow magnification

The next command specifies the data source and how many characters are in the current 
field.
Default Value: 0,14

Values for n: 

Important  The JIS-ITF barcode always includes an interpretive field located underneath 
the barcode field. This symbology cannot achieve a true 2.5 to 1 ratio due to the printhead 
dot size limitations. The actual ratio is 2.4 to 1.

D0,m This field acquires data from a host. The value for ,m is the 
data length: 6 (Condensed), 14 (Standard), or 16 (Extended).

D2,m This field is a slave field and acquires its data from the ,m field.

D3,m The printer specifies the data during program mode (fixed). 
The ,m value dictates the JIS-ITF type. If the length of the data 
is not exactly 6, 14, or 16, it will round up to the next highest 
value (JIS-ITF type) and pad with zeros.
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c16,m1,m2

Description  HIBC Code 128

Purpose  To specify an HIBC Code 128 barcode field.

Syntax  c16,m1,m2

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The c16 command has two arguments, m1 and m2, and m1 defaults to 0.

The HIBC Code 128 barcode supports these modes:

m1 HIBC Code 128 Mode

0 Primary format.

1 Alternate Primary format.

2,m2 Secondary format with m2 as the linkage character and 
field identifier.

3 Single format.

4 First data format.

5,m2 Second data format with m2 as the linkage character and 
field identifier.

6 Multiple data format.
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c17,m1,m2,m3,m4,m5,m6

Description  Data Matrix Symbology Versions ECC-100 and ECC-200

Purpose  To specify a Data Matrix Symbology Versions ECC-100 and 
ECC-200 barcode field.

Syntax  c17,m1,m2,m3,m4,m5,m6

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command selects the Data Matrix symbology. Data Matrix is a 2d symbology 
consisting of square modules arranged within a finder pattern. The two versions of Data 
Matrix that are supported are ECC-100 and ECC-200. 

The names, purposes, and default values of these parameters are listed below:

Argument Purpose Default Value

m1 Enhanced error correction 200 200 

m2 Square mode 0

m3 Position of current symbol in group 0

m4 Total number of symbols in group m3 parameter

m5 File ID number 1

m6 File ID number 1
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c18,m1,m2,m3

Description  QR Code

Purpose  To specify a QR Code barcode field.

Syntax  c18,m1,m2,m3 

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The c18 command has three arguments.

You can only produce QR symbols up to 3550 characters.

The names, purposes, and default values of these parameters are listed here:

Argument Purpose Default/Possible Values

m1 Enhanced error correction 
200

2/1,2 for Model 1,2 resp.

m2 Square mode M/L,M,Q,H for 7,15,25,30% error 
correction, resp.

m3 Mask number 8/0-7 for mask type, 8 for auto-
selection of mask
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c19,m1,m2

Description  MicroPDF417

Purpose  To specify a MicroPDF417 barcode field.

Syntax  c19,m1,m2

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

These label examples show the barcode position might differ when the barcode is rotated 
180 degrees:

The c19 command has 2 arguments.

When rotated 180 degrees, barcode position could differ.

The names, purposes, and default values of these parameters are listed below:

Intermec 3400D Printer Label

Virtual Device-I Printer Label

Argument Description Default Value

m1 Number of columns of data in barcode; possible values of 0–4, where 0 
lets the printer set the best-fitting value.

 0

m2 Number of rows of data in barcode; possible values depend on the 
value of m1, and 0 lets the printer set the best-fitting value.

0
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Bn,name

Description  Barcode Field, Create or Edit

Purpose  To edit or create a barcode field.

Syntax  Bn,name

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  By creating a barcode field and enabling the interpretive parameter, you 
consequentially create an interpretive field. 

Important  If the field number is out of range, an error code 38 is generated.

yn

Description  Bitmap Cell Height for Graphic or UDF, Define

Purpose  To determine the height of a graphic or user-defined font.

Syntax  yn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Sets the graphic or user-defined font height.

Default: 
n = 1 Bitmap Fonts
n = 10 Outline fonts
n = 50 graphics

Values for n: 1 to 799 
Note • Things to be aware of:

• n represents the number of rows for the graphic or font bitmap.

• If an invalid height is entered, an error code of 52 is generated.

xn

Description  Bitmap Cell Width for Graphic or UDF, Define

Purpose  To determine the max width of a graphic or user-defined font. 

Syntax  xn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
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Tn

Description  Bitmap User-Defined Font, Clear or Define

Purpose  To clear or create a user-defined bitmap font set. 

Syntax  Tn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  You can recreate an existing font, but in order to edit the characters you must 
transmit the complete font. Defining a font previously sent erases all previous characters 
in the font.

bn

Description  Border Around Human-Readable Text, Define

Purpose  To add a border around a human-readable field. 

Syntax  bn

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

These label examples show that when used with smooth fonts, the border does 
not enclose character descenders.

Intermec 3400D Printer LabelVirtual Device-I Printer Label
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Wn,name

Description  Box Field, Create or Edit

Purpose  To edit or create a box field.

Syntax  Wn,name

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command is used to design a box field.

Default: n = 0
Values for n: 0 – 199; name is optional

Names can be up to 8 characters but cannot start with a number.

Box field command parameters are as follows: 

Xn

Description  Character Bitmap Origin Offset, Define

Purpose  To determine the offset, to the right, of all characters in a font. 

Syntax  Xn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  This command specifies the offset (to the right) of all characters in a font. The 
value for n = the number of columns to the right that the character origins shift.

Default: n = 0 

Values for n: 0 – 800

Important  You can use this command only with bitmapped fonts.

Field Origin 0
Default 0,0
Field Direction f Default = 0 degrees
Box Length l   Default = 100
Box Height h Default = 100
Box Width w  Default = 1
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rn

Description  Character Rotation or Barcode Ratio, Define

Purpose  To determine the character rotation for human-readable fields, or the barcode 
ratio for a barcode field. 

Syntax  rn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Character Rotation Default 
n = 0
1 = horizontal
2 = 90º counterclockwise

Bar Code Ratio Default: n = 1

Barcode fields, ratio of wide to narrow bar
Accepted values for n: 

0 = 2.5 to 1
1 = 3.0 to 1
2 = 2.0 to 1
3 = 3.0 to 1
n = 3 is used for Code 39 and creates a ratio of 7 dots to 3 dots.

p,n1,n2,n3,n4

Description  Code 39 Prefix Character, Define

Purpose  To determine the prefix for a Code 39 field.

Syntax  p,n1,n2,n3,n4

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer. 

Default is for No prefix
Accepted values for n: A - Z (case sensitive) and 0 – 9

After selecting the prefix, enter Code 39.

Example  c0,3;pABC4; not pABC4;c0,3;. Use the @ character for n1 to clear all 
prefixes. Prefix characters are not represented in the interpretive field.
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C

Description  Command Tables, Load

Purpose  To download a command table.

Syntax  C

Not Supported  This command does not work on the Zebra printer with Virtual Device-I, 
or it has significant deviations from the 3400D printer. 

New commands take effect when the printer is turned off and then on, or when the printer 
is reset. If you wish to only change a few commands use the <ESC>Z command, acquire 
the output, alter it, and then send it back to the printer. When you wish to change the 
contents of a table you must send the complete table to the printer in ASCII characters in 
hexadecimal form. Values that are not changed remain the same.

N

Description  Current Edit Session, Save

Purpose  To save the current page, format, UDC, or UDF being edited.

Syntax  N

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The current page, format, or UDC is automatically saved when you call a new one 
or when you exit Program mode.

en,m1,m2

Description  Data Source for Format in a Page, Define

Purpose  To define a data source for a format assigned to a page position.

Syntax  en,m1,m2

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: 

n = 0
m = a
m2 = 0

Accepted values for n: 
0 = formats receive their data while in Print mode
1 = format is slave to another format on this page.
07/05/2018 Virtual Device-I User Guide P1069056-003



Commands
Program Mode Commands

98
Dn

Description  Field, Delete

Purpose  To delete field n from the format.

Syntax  Dn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: n = 0
Accepted values for n: 0 – 199

Notes  It is not allowable to delete the last field within a format. If the current field is 
deleted, the field pointer will point to the next field. If the master field is deleted, all slave 
fields of the master are deleted.

dn,m1,m2

Description  Field Data, Define Source

Purpose  To determine a data source for the current field and how many characters are in 
the field.

Syntax  dn,m1,m2

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Default values bar code fields: 0,20,0 

Default values human-readable fields: 0,30,0 
Accepted values for n: 

0 = Data entered while in Print mode
1 = Data entered while in Print mode
2 = Data from field, m1
3 = Fixed data

Accepted values for m1 (d0 or d1): 0 - 3550
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f

Description  Field Direction, Define

Purpose  To determine the field rotation.

Syntax  fn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: n = 0
Accepted values for n: 

0 = Horizontal (all are rotated counterclockwise from horizontal)
1 = 90°
2 = 180°
3 = 270°

on,m

Description  Field Origin, Define

Purpose  To determine the origin of a field.

Syntax  on,m

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: 

n = 0 
m = 0 

Accepted values for n and m: 
n = 0 – 19999 
m = 0 – 19999
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Zn

Description  Font Character Width, Define

Purpose  To determine the amount of space from the origin of one letter to the origin of 
the next.

Syntax  Zn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Accepted for bitmap characters only. Intercharacter space command (zn) is 
ignored by the printer if this command is used.

Default: Bitmap width of characters, minus font character offset (Xn) plus intercharacter space 
(zn)
Accepted values for n: n = 1 – 799

cn,m

Description  Font Type, Select

Purpose  To choose a font type for human-readable fields.

Syntax  cn,m

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Depending on what human-readable fonts your printer supports, you can set n 
from 0 to 56.

A or F

Description  Format, Create or Edit

Purpose  To create or edit a format.

Syntax  A or F

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  If the format number is out of range, an error code 36 is generated.
P1069056-003 Virtual Device-I User Guide 07/05/2018



101Commands
Program Mode Commands
qn

Description  Format Direction in a Page, Define

Purpose  To determine the direction of a format on a page.

Syntax  qn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: n  =  0
Accepted values for n: 

0 = Horizontal (all are rotated counterclockwise from horizontal)
1 = 90°
2 = 180°
3 = 270°

En

Description  Format, Erase

Purpose  To erase a format.

Syntax  En

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: NONE
Accepted values for n: 1 – 19

Important  Cannot erase format 0.

On,m

Description  Format Offset Within a Page, Define

Purpose  To determine the format offset within a page.

Syntax  On,m

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: 

n = 0
m = 0

Accepted values for n and m: 
n = 0 – 19999
m = 0 – 19999
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mp

Description  Format Position From Page, Delete

Purpose  To delete a format from within a page. 

Syntax  mp

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: p = a
Accepted values for p: a – z

Mp,n

Description  Format Position in a Page, Assign

Purpose  To assign a format to a page position. 

Syntax  Mp,n

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Important  If the format ID is out of range, an error code of 36 is generated. A format can 
be in several locations within a page.

Notes  n is the numeric format ID, and p is the page position.

cn

Description  Graphic, Select

Purpose  To choose a graphic for graphic fields. 

Syntax  cn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: n 
Accepted values for n: 0 – 99
Important • Valid for graphic fields only.
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u

Description  Graphic or UDC, Define

Purpose  To map a column of bitmap for a graphic or a font character.

Syntax  u

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

hn

Description  Height Magnification of Bar, Box, or UDC, Define

Purpose  To determine box, barcode, or UDC height magnification. 

Syntax  hn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  n corresponds to the vertical magnification of the character bitmap for human-
readable fields, POSTNET symbology, and graphics. The printer uses the highest value 
possible when n is set too large. For a 200 dpi printer in Advanced mode, a dot is 5 mil; for 
a 400 dpi printer a dot is 2.5 mil.

Hn

Description  Human-Readable Field, Create or Edit

Purpose  To edit or create a human-readable field.

Syntax  Hn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: n 

Values for n: 0 – 199

Notes  n corresponds to the vertical magnification of the character bitmap for human-
readable fields, POSTNET symbology, and graphics. The printer will use the highest value 
possible when n is set too large. For a 200 dpi printer in Advanced mode, a dot is 5 mil; for 
a 400 dpi printer a dot is 2.5 mil.
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zn

Description  Intercharacter Space for UDF, Define

Purpose  To determine spacing that is added to the default intercharacter gap length for a 
bitmap font. 

Syntax  zn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: n = 2
Accepted values for n: 0 – 199

Notes  n represents the number of dots per pixels. For a 200 dpi printer in Advanced 
mode, a dot is 5 mil; for a 400 dpi printer a dot is 2.5 mil.
Important • If an invalid lengths occurs, an error code 52 is generated. 

In

Description  Interpretive Field, Edit

Purpose  To edit an interpretive field.

Syntax  In

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
Default Value: n = 0
Accepted values for n: 1 – 199

Notes  You cannot create interpretive fields when using this command. You can only 
create or delete them when you enable the interpretive of the barcode field. Every 
interpretive field is counted as a separate field in the maximum number of 200 fields.
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in

Description  Interpretive Field, Enable or Disable

Purpose  To determine if the interpretive field of the current barcode field prints.

Syntax  in

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Use the I command when you want to edit an interpretive field. In the interpretive 
field, the human-readable font prints 2 dots left aligned under the barcode.

Default: n = 0
Accepted values for n: 

0 = disabled
1 = enable with start and stop characters
2 = enable without start and stop characters

ln

Description  Length of Line or Box Field, Define

Purpose  To determine the length of a line or box.

Syntax  ln

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  When in Advanced mode, a dot for a 200 dpi printer is 5 mil, and a dot for a 400 
dpi printer is 3.3 mil.
Default Value: n = 100
Accepted values for n: 1 – 9999

Ln

Description  Line Field, Create or Edit

Purpose  To edit or create a line field.

Syntax  Ln

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The name parameter is optional and can consist of 8 ASCII characters
Default Value: n = 0
Accepted values for n: 0 – 199
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J

Description  Outline Font, Clear or Create

Purpose  To clear or create an outline font or graphic.

Syntax  J

Not Supported  This command does not work on the Zebra printer with Virtual Device-I, 
or it has significant deviations from the 3400D printer.

j

Description  Outline Font, Download

Purpose  To download outline font descriptions.

Syntax  j

Not Supported  This command does not work on the Zebra printer with Virtual Device-I, 
or it has significant deviations from the 3400D printer. 

When you choose the j command, the printer stores the received font description.

Sn

Description  Page, Create or Edit

Purpose  To edit or create a page.

Syntax  Sn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Default page (page 0) cannot be altered.
Default Value: NONE
Accepted values for n: 1 – 9
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sn

Description  Page, Delete

Purpose  To delete a page.

Syntax  sn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  Default page (page 0) cannot be altered.
Default Value: NONE
Accepted values for n: 1 – 9

gn

Description  Pitch Size, Set

Purpose  To set the pitch size for a human-readable field. 

Syntax  gn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  To scale outline fonts smoothly, use the pitch size command.
Default Value: n = 12
Accepted values for n: 1 – 50

kn

Description  Point Size, Set

Purpose  To set the point size for a human-readable field. 

Syntax  kn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  One point size is equivalent to 1/72 inch. The higher the point size, the larger the 
characters.
Default Value: n = 12
Accepted values for n: 4 – 288
07/05/2018 Virtual Device-I User Guide P1069056-003



Commands
Program Mode Commands

108
v

Description  Print Line Dot Count Limit, Set

Purpose  To limit the print line dot count limit. 

Syntax  v

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The printer ignores this because it is a null command.

R

Description  Program Mode, Exit

Purpose  To switch from program mode to print mode and save the format or page 
currently being edited.

Syntax  R

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Gn

Description  User-Defined Character, Clear or Create

Purpose  To clear or create graphic bitmaps.

Syntax  Gn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The printer erases and redefines a graphic after you define it.
Default Value: NONE
Accepted values for n: 0 – 99
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Un

Description  User-Defined Character Field, Create or Edit

Purpose  To create or edit a graphical field.

Syntax  Un

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  The name parameter is optional and can consist of 8 ASCII characters (excluding 
the semicolon) and cannot start with a number.
Default Value: n = 0
Accepted values for n: 0 – 199

tn

Description  User-Defined Font Character, Create

Purpose  To identify the next font to be defined.

Syntax  tn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Notes  n is a decimal representation of an ASCII character. Existing characters are 
erased by the printer.
Default Value: NONE
Accepted values for n: 0 – 255
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wn

Description  Width of Line, Box, Bar, or Character, Define

Purpose  To determine the width magnification of a line, box, barcode, or character. 

Syntax  wn

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Default value for line, box, bar code fields, and graphics: n = 1
Accepted values for n: 

Line and box fields: 1 – 9999 

Barcode fields: 1 – 99 

Graphics: 1 – 999

Default value for human-readable fields and POSTNET: n = 2
Accepted values for human-readable fields and POSTNET: 1 – 250
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A

Description  Ambient Temperature, Transmit

Purpose  Transmits the ambient temperature sensor output back to the host.

Syntax  A

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with APL-I firmware with the following difference and output:

The Zebra printer transmits the Fahrenheit temperature back to the host.

The 3400D printer transmits the A/D sensor output back to the host.

;

Description  Command Terminator

Purpose  To end all commands in Test and Service mode.

Syntax  ;

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

K

Description  Dark Adjust

Purpose  To change the darkness of the print on labels.

Syntax  K

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

D

Description  Factory Defaults, Reset

Purpose  To set the printer configuration to the factory defaults.

Syntax  D

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
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f

Description  Formats, Print

Purpose  To print all stored formats.

Syntax  f

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

h

Description  Hardware Configuration Label, Print

Purpose  To print a hardware configuration label.

Syntax  h

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

The label examples show how unsupported values on the label could differ, but the overall 
format is the same:

Intermec 3400D Printer Label

Virtual Device-I Printer Label
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T

Description  Label Taken Sensor Value, Transmit

Purpose  To send the label taken sensor and output back to the host. 

Syntax  T

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer. 

p

Description  Pages, Print

Purpose  To print the pages stored on the printer.

Syntax  p

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

C

Description  Pitch Label, Print

Purpose  To print the pitch label.

Syntax  C

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
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Q

Description  Print Quality Label, Print

Purpose  To print the print quality program and model number label.

Syntax  Q

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

The label examples show that the data on the format differs slightly: 

Intermec 3400D

Virtual Device-I Printer Label
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p

Description  Printhead Temperature Sensor Value, Transmit

Purpose  To send the printhead thermistor A/D output back to the host. 

Syntax  p

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

M

Description  Reflective Sensor Value, Transmit

Purpose  To send the label mark reflective sensor A/D output back to the host.

Syntax  M

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.
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s

Description  Software Configuration Label, Print

Purpose  To print a software configuration label.

Syntax  s

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

The label examples show how the unsupported values on the label could differ, but overall 
the format is the same.

Virtual Device-I Printer Label
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R

Description  Test and Service Mode, Exit

Purpose  To make the printer exit Test and Service mode.

Syntax  R

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

G

Description  Transmissive Sensor Value, Transmit

Purpose  To send the label gap transmissive sensor and output back to the host.

Syntax  G

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

Intermec 3400D Printer Label
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g

Description  User-Defined Characters (UDC) and Graphics, Print

Purpose  To print the user-defined characters and graphics stored on the printer.

Syntax  g

Supported  Based on testing, this command works the same on the Zebra printer with 
Virtual Device-I firmware as on the 3400D printer.

t

Description  User-Defined Fonts, Print

Purpose  To print the user-defined fonts stored on the printer.

Syntax  t

Partially Supported  Based on testing, this command is partially supported on the 
Zebra printer with Virtual Device-I firmware with the following differences and outputs:

Notes  There are slight differences in spacing, and it is optimized for 4 in. x 6 in. label.
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Set/Get/Do (SGD) Commands
The following SGD commands were added for use with your Virtual Device app. For more 
detailed information on SGD commands, see the Programming Guide for ZPL II®, ZBI 2, 
Set/Get/Do, Mirror, and WML (formerly the ZPL II Programming Guide).

apl.enable

Description  This command enables or disables a Virtual Device app.

Type  setvar

apl.framework_version

Description  This command returns the level of support for Virtual Devices in the printer 
operating system.

Type  getvar

Note • 

• ZPL and CPCL may not function normally when a Virtual Device app is enabled. 
• You must restart the printer after changing the value of apl.enable.

Commands Details

setvar This command instructs the printer to enable a virtual device. 

Format: ! U1 setvar "apl.enable" "value" 
Values: 

"apl‐i" = enable Virtual Device-I
"none" = disable any Virtual Device app (ZPL and CPCL function normally)

Example 1 •This example shows how to enable the Virtual Device-I app:

! U1 setvar "apl.enable" "apl‐i"

Example 2 •This example shows how to disable the Virtual Device-I app:

! U1 setvar "apl.enable" "none"

Commands Details

getvar Format: ! U1 getvar "apl.framework_version" 
07/05/2018 Virtual Device-I User Guide P1069056-003



ZDownloader Utility
This section provides you with the instructions for downloading and installing the 
ZDownloader Utility.
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Downloading the ZDownloader Utility

To download the ZDownloader Utility, perform the following from your computer:

1. Open a web browser and navigate to www.zebra.com.

2. Click on the Support & Downloads header on the webpage.

3. Select a printer.

4. When the printer page opens, locate and select the Software Utilities tab.

5. Scroll down to the ZDownloader Utility and select the Download link. 

6. Click on the Accept and Begin Download Now button. 

The installation file download will begin.

Note • You will be prompted to create a user profile or login to www.zebra.com with an 
existing profile to download the ZDownloader Utility.
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Installing the ZDownloader Utility
To install the ZDownloader Utility, perform the following from your computer:

1. Run the installation file after the download is complete.

2. If you are prompted to allow the application to make changes to your computer, click 
Yes.

The utility installs on your computer. When installation is complete, the Firmware 
Downloader and ZBI Key Manager installation wizard appears.

3. Click Next.

The End User License Agreement appears.
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4. Read the terms of the agreement.

5. Click the checkbox to accept the terms.

6. Click Next.

7. Click Next.

The installation wizard displays information about the installation.
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8. Click Next.

The installation wizard installs the application.

9. Click Finish to close the wizard.
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Index
A
abort print job, 45
advanced mode, select, 48
alphanumeric field separator, 48
amount of storage, define, 63
application installation

acquiring the app, 15
canceling a download in progress, 26
downloading the app to printers, 24

auto-detect printers, 17
auto-transmit 1, 2, and 3, disable, 64
auto-transmit 1, enable, 63
auto-transmit 2, enable, 63
auto-transmit 3, enable, 64

B
bar code field, create or edit, 93
bar code select type, 74
batch count, set, 49
bitmap cell height for graphic or UDF, define, 93
bitmap cell width for graphic or UDF, define, 93
bitmap user-defined font, clear or define, 94
border around human-readable text, define, 94
box field, create or edit, 95

C
character bitmap origin offset, define, 95
character rotation or bar code ratio, define, 96
clear all data, 49
clear data from current field, 49
codabar, 77
code 11, 78
code 128, 78
code 16K, 81
code 2 of 5, 77
code 39, 75
code 39 prefix character, define, 96
code 49, 81
code 93, 76
command tables, load, 97
command terminator, 50, 111
command terminator 2, 50
commands

configuration, 63
immediate, 45
print, 48
program mode, 74
test and service, 111
07/05/2018 Virtual Device-I User Guide P1069056-003 



Index126
configuration commands, 63
amount of storage, define, 63
auto-transmit 1, 2, and 3, disable, 64
auto-transmit 1, enable, 63
auto-transmit 2, enable, 63
auto-transmit 3, enable, 64
cutter, enable or disable, 64
dark adjust, set, 65
emulation or advanced mode on power-up, 65
end-of-print skip distance, set, 65
IBM language translation, enable or disable, 66
intercharacter delay, set, 66
label rest point, adjust, 67
label retract distance, set, 67
label retract, enable or disable, 67
label stock type, select, 68
label width, set, 68
maximum label length, set, 68
media sensitivity, select, 69
message delay, set, 69
number of image bands, set, 69
postamble, set, 70
preamble, set, 70
print speed, set, 71
printer language, select, 71
printhead loading mode, select, 72
self-strip, enable or disable, 72
top of form, set, 73

configuration parameters, transmit, 50
connectivity options, 12
current edit session, save, 97
cut

print commands, 51
cutter, enable or disable, 64

D
dark adjust, set, 65
dark adjust, test and service commands, 111
data matrix symbology versions ECC-100 and 

ECC-200, 90
data shift - international characters, 51
data source for format in a page, define, 97
direct graphics mode, select, 51
disabling the Virtual Device

by apl.enable SGD command, 119
through the control panel

QLn320 and QLn220 printers, 32
QLn420 printers, 29
ZT230, ZT400 series, ZT510, ZT600 series,

ZD500 series, and ZD600 series
printers, 35

ways to enable/disable, 28

E
emulation mode, 51
emulation or advanced mode on power-up, 65
enabling the Virtual Device

by apl.enable SGD command, 119
through the control panel

QLn320 and QLn220 printers, 32
QLn420 printers, 29
ZT230, ZT400 series, ZT510, ZT600 series,

ZD500 series, and ZD600 series
printers, 35

ways to enable/disable, 28
end-of-print skip distance, set, 65
error code request, 45

F
factory default, reset, 111
features, 11
field decrement, set, 53
field direction, define, 99
field increment, set, 53
field origin, define, 99
field, delete, 98
field, select, 52
first data entry field, select, 53
font type, select, 100
font, transmit, 54
form feed, 54
format direction in a page, define, 101
format offset within a page, define, 101
format position from page, delete, 102
format position in a page, assign, 102
format, create or edit, 100
format, erase, 101
format, select, 55, 102
format, transmit, 56
formats, print, 112

G
graphic or UDC, define, 103

H
hardware configuration label, print, 112
height magnification of bar, box, or UDC, define, 

103
HIBC code 128, 89
HIBC code 39, 80
human-readable field, create or edit, 103
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I
IBM language translation, enable or disable, 66
immediate commands, 45

abort print job, 45
error code request, 45
label and gap length, transmit, 45
remaining quantity and batch count, transmit, 

46
reset, 46
status dump, 46
status enquiry, 47

increment and decrement, disable, 56
intercharacter delay, set, 66
intercharacter space for UDF, define, 104
interleaved 2 of 5, 76
interpretive field, edit, 104
interpretive field, enable or disable, 105
IP Ethernet printers

auto-detect, 17
manually add, 18

J
JIS-ITF, 88

L
label and gap length, transmit, 45
label rest point, adjust, 67
label retract distance, set, 67
label stock type, select, 68
label taken sensor value, transmit, 113
label width, set, 68
label, retract, enable or disable, 67
length of line or box field, define, 105
liability, 2
line field, create or edit, 105

M
manually add printers, 18
maxicode, 84, 86
maximum label length, set, 68
media sensitivity, select, 69
Memory Usage, Transmit, 56
memory usage, transmit, 56
message delay, set, 69
MicroPDF417, 92
modifying printer communication settings 

through ZDownloader, 22

N
next data entry field, select, 57
number of image bands, set, 69
numeric field separator, 57

O
options selected, transmit, 58
outline font, clear or create, 106
outline font, download, 106

P
page, create or edit, 106
page, delete, 107
page, select, 58
page, transmit, 59
pages, print, 113
parallel printers, 18
PDF417, 83
pitch label, print, 113
pitch size, set, 107
point size, set, 107
postamble, set, 70
POSTNET, 82
preamble, set, 70
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print commands, 48
advanced mode, select, 48
alphanumeric field separator, 48
batch count, set, 49
clear all data, 49
clear data from current field, 49
command terminator 1, 50
command terminator 2, 50
configuration parameters, transmit, 50
cut, 51
data shift - international characters, 51
direct graphics mode, select, 51
emulation mode, enter, 51
field decrement, set, 53
field increment, set, 53
field, select, 52
first data entry field, select, 53
font, transmit, 54
form feed, 54
format, select, 55
format, transmit, 56
increment and decrement, disable, 56
memory usage, transmit, 56
next data entry field, select, 57
numeric field separator, 57
options selected, transmit, 58
page, select, 58
page, transmit, 59
print, 59
printhead parameters, transmit, 59
program mode, enter, 60
program number, transmit, 60
quantity count, set, 60
start and stop codes (code 39), print, 61
test and service mode, enter, 61
user-defined characters, transmit, 61
user-defined tables, transmit, 61
warm boot, 62

print line dot count limit, set, 108
print quality label, print, 114
print servers, 12
print speed, set, 71
printer language, select, 71
printhead loading mode, select, 72
printhead parameters, transmit, 59
printhead temperature sensor value, transmit, 

115
program mode commands, 74

bar code field, create or edit, 93
bar code, select type, 74
bitmap cell height for graphic or UDF, define, 

93
bitmap cell width for graphic or UDF, define, 93
bitmap user-defined font, clear or define, 94
border around human-readable text, define, 94
box field, create or edit, 95
character bitmap origin offset, define, 95
character rotation or bar code ratio, define, 96
codabar, 77
code 11, 78
code 128, 78
code 16K, 81
code 2 of 5, 77
code 39, 75
code 39 prefix character, define, 96
code 49, 81
code 93, 76
command tables, load, 97
current edit session, save, 97
data matrix symbology versions ECC-100 and 
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ECC-200, 90
data source for format in a page, define, 97
field data, define source, 98
field direction, define, 99
field origin, define, 99
field, delete, 98
font character width, define, 100
font type, select, 100
format direction in a page, define, 101
format offset within a page, define, 101
format position from page, delete, 102
format position in a page, assign, 102
format, create or edit, 100
format, erase, 101
graphic or UDC, define, 103
graphic, select, 102
height magnification of bar, box, or UDC, 103
HIBC code 128, 89
HIBC code 39, 80
human-readable field, create or edit, 103
intercharacter space for UDF, define, 104
interleaved 2 or 5, 76
interpretive field, edit, 104
interpretive field, enable or disable, 105
JIS-ITF, 88
length of line or box field, define, 105
line field, create or edit, 105
maxicode, 84, 86
MicroPDF417, 92
outline font, clear or create, 106
outline font, download, 106
page, create or edit, 106
page, delete, 107
PDF417, 83
pitch size, set, 107
point size, set, 107
POSTNET, 82
print line dot count limit, set, 108
program mode, exit, 108
QR code, 91
UPC/EAN, 79
user-defined character field, create or edit, 109
user-defined character, clear or create, 108
user-defined font character, create, 109
width of line, box, bar, or character, define, 110

program mode, enter, 60
program number, transmit, 60

Q
QR code, 91
quantity count, set, 60

R
remaining quantity and batch count, transmit, 46
reset printer, 46

S
self-strip, enable or disable, 72
serial interface

add printers, 18
Set/Get/Do (SGD) commands, 119
software configuration label, print, 116
start and stop codes (code39), print, 61
status dump, 46
status enquiry, 47

T
test and service commands, 111

command terminator, 111
dark adjust, 111
factory defaults, reset, 111
formats, print, 112
hardware configuration label, print, 112
label taken sensor value, transmit, 113
pages, print, 113
pitch label, print, 113
print quality label, print, 114
printhead temperature sensor value, transmit, 

115
reflective sensor value, transmit, 115
software configuration label, print, 116
test and service mode, exit, 117
transmissive sensor value, transmit, 117
user-defined characters (UDC) and graphics, 

print, 118
user-defined fonts, print, 118

test and service mode, enter, 61
test and service mode, exit, 117
top of form, set, 73
TPCL mode supported commands, 40
transmissive sensor value, transmit, 117

U
UPC/EAN, 79
USB printers, 17
user-defined character field, create or edit, 109
user-defined character, clear or create, 108
user-defined characters (UDC) and graphics, 

print, 118
user-defined characters, transmit, 61
user-defined font character, create, 109
user-defined fonts, print, 118
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user-defined tables, transmit, 61

V
version

level of support for Virtual Devices, 119

W
warm boot, 62
width of line, box, bar, or character, define, 110
wired print server

auto detect, 17
for more information, 12
manually add, 18

wireless print server
auto detect, 17
for more information, 12
manually add, 18

Z
ZDownloader

adding printers, 16
canceling a download in progress, 26
deleting printers, 23
downloading the Virtual Device app to printers, 

24
downloading ZDownloader, 121
installing ZDownloader, 122
modifying printer settings, 22

zebra printer setup utility for android devices, 16
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